CONTENTS

WELCOME TO TRANSMIT! .......................................................................................... 3
THE BASICS .................................................................................................................. 4
FTP 101 ......................................................................................................................... 4
Starting Up ..................................................................................................................... 4
The Interface ................................................................................................................ 5
Expert Interface Tricks ................................................................................................. 7
MAKING A CONNECTION ......................................................................................... 8
The Connection Panel ................................................................................................ 8
Favorites ....................................................................................................................... 8
TRANSFERRING FILES .......................................................................................... 10
Downloading ............................................................................................................... 10
Uploading .................................................................................................................... 11
Duplicate Files .......................................................................................................... 11
WORKING WITH FILES ..................................................................................... 13
Renaming Files .......................................................................................................... 13
Deleting Files ............................................................................................................. 13
Moving Files .............................................................................................................. 14
Learning More About Files ..................................................................................... 14
Setting Permissions on Files .................................................................................. 14
Synchronizing Files ................................................................................................. 15
Reading Files ........................................................................................................... 17
Creating Folders ....................................................................................................... 17
EXTRA CREDIT ................................................................................................. 18
Graphic Preview ...................................................................................................... 18
Transcript Window .................................................................................................. 18
Contextual Menus .................................................................................................... 19
Finder Icon Progress Bars ....................................................................................... 19
Using URL’s .............................................................................................................. 19
Files & Filetypes ....................................................................................................... 20
APPLESCRIPT ................................................................................................. 23
About AppleScript .................................................................................................. 23
Transmit’s Dictionary ............................................................................................... 23
Example Script .......................................................................................................... 25
PREFERENCES EXPLAINED ........................................................................ 26
Files ........................................................................................................................... 26
Transfers .................................................................................................................... 26
Network ...................................................................................................................... 27
Misc ........................................................................................................................... 28
MENUS EXPLAINED .................................................................................. 31
Apple .......................................................................................................................... 31
File .............................................................................................................................. 31
Edit ................................................................................................................................ 33
Purchase (Demo Only) ............................................................................................ 33
Windows ..................................................................................................................... 34
ACKNOWLEDGMENTS .................................................................................. 35
WELCOME TO TRANSMIT!

The year was 1977. Steve Miller filled the airwaves. Star Wars took the theaters by storm. And somewhere in California, a handful of nocturnal, heavily-bearded computer fanatics were dreaming up a method of transferring files from one computer to another. Out of these discussions came the first working draft of the “file transfer protocol” standard: FTP. At that time, however, no one had any idea that out of an era of Pong and pogo would spring a method of flinging files around the globe. Not a soul predicted that something called “the Internet” would one day make FTP a daily part of a whole lot of people’s lives. Truly, FTP is here for good — after all, it’s held up pretty well over the last 20-odd years.

Macintosh FTP clients, however, haven’t aged quite so gracefully – while the MacOS™ has leaped forward to become a top-class operating system, most Macintosh FTP programs still look and feel positively System 7.

Enter Transmit.

By using Transmit, you’ve just guaranteed yourself an escape from the world of old-fashioned FTP. Transmit was designed from the start to be clean, beautiful, and powerful all at once, just like the MacOS™ is. The result should be obvious: the single best way to transfer files from one place to another on any platform – right here, of course, on the Macintosh. We’re very proud of what we’ve made, and we hope you’re impressed as well!
FTP 101

Your pre-press service bureau is in another area code, and you need to ship them the latest proof of your magazine, stat! Or, you’ve just been tasked with maintaining the company’s web page, and while the artists and engineers wisely use Macs, the site is hosted on a Unix box in Virginia! Maybe you want to download the latest version of your favorite Macintosh utility, FaceSlapper Pro, from the company’s server.

Congratulations: you need FTP!

If you need to send or receive a file from one computer to another over the Internet, you need FTP. When you use an FTP client, you’re basically connecting to another computer’s file system — just like your own hard drive, but somewhere else. Through FTP you can download, upload, delete, rename, move, and play with remote files with total ease and little technical complication.

You connect to FTP servers using a specific username and password to “log-in” to a particular account. Well, that’s not entirely true — certain FTP servers only offer what’s called “anonymous FTP access”, which basically means that you’re logging into a general account with only limited access. You won’t need a username or a password to log in to these servers. Think of it this way: if a standard FTP server is a private book collection, than an anonymous FTP server is a public library — a place for everyone where you can pick up goodies for free. (Without the late fees, of course.)

There are a whole bunch of tremendously useful anonymous FTP servers on the web, that can dish up everything from tax forms (ftp.irs.gov) to the latest Apple system software (ftp.info.apple.com).

(Oh, and if you’re really new to the Internet, get used to those crazy. clumps. of. words. They’re Internet “addresses”, the Internet equivalent of phone numbers.)

Transmit will let you access each and every FTP server in the world, and all from the comfort of your desktop. So sit back, relax, and let’s give her a go!

Starting Up

If you’re reading this, you probably already have a copy of Transmit on your hard-drive. (If not, you can download one from http://www.panic.com) To start Transmit, all you need to do is double click the Transmit icon, which should look like this:
When Transmit starts up, you’ll see a screen much like the following:

User, meet the Transmit interface. Transmit interface, meet the user. Get real cozy with this window, because it’s the heart and soul of most everything you’ll do in Transmit. In this particular screenshot, Transmit’s waiting to make a connection. That’s why the right hand pane – which usually contains the remote list of files, otherwise known as “their stuff” – is politely asking you to login. But let’s not get ahead of ourselves: here’s a closer look at what makes up the basic interface.

**The Interface**

This is what Transmit’s main interface looks like. You’re probably used to most of these controls and widgets if you’ve used the MacOS before. If you’re a System 7 user, then a handful of these concepts will be new to you, as they were introduced with MacOS 8. But don’t worry, we’ll get you up to speed.

You’ll notice that the interface is split into two halves. (This doesn’t necessarily have to be the case — see the preferences section later in this document). This two-halves design, with local files on the left and remote files on the right, allows you to easily access and
work with the files you normally deal with. You see, we spare you the “Standard file dialogs” — those boxes that pop up when you open or save a file — and instead built the file dialog right into the interface. If you come from other FTP programs, this might take a little getting used to. But trust us, once it’s a part of your routine, you’ll never go back.

Here’s a look at Transmit’s major interface elements up close.

**Your Stuff**

The “Your Stuff” panel lives true to its name: a complete list of your stuff. All your hard drives, folders, and files, including any network drives that you may have mounted via the Chooser. It should be instantly familiar to you if you’re a Mac user — you navigate it just like you would a standard Save or Open dialog box.

![History Popup, Parent Button, Sort Order](image)

Double click folders to go into them. Use the “parent button” to pop out one level to the folder containing the folder you’re viewing. Click the “history popup” list to see and quickly jump to the folders that the current folder is contained in.

You can also customize the list itself, much like you can with the list views in MacOS 8. Clicking the “sort by name” button will sort the list alphabetically based on name. Clicking “sort by size” will sort your files by their size. When you click the “sort order” button — it looks like a little arrow — your list will reverse: if you were viewing alphabetically from a to z, the files will be flipped and displayed from z to a. If you were viewing by size, the files will flip and be listed from largest to smallest. The “sort order” button acts as a toggle — every time you click it the order flips.

**Their Stuff**

The “Their Stuff” panel works just like “Your Stuff” does — except, unsurprisingly, it contains a list of remote files. Navigate through their stuff just as you would your stuff.

**Trashcan**

Dragging items to the Trashcan causes the computer to sing the “Three’s Company” theme in Svengali. Just kidding — dragging items to the trash deletes them.

**Status and Stop**

Keep an eye on the status line — it’s the best place to find out what’s going on with Transmit at all times. Usually, Transmit should report itself as “Idle.” While a transfer’s going on, the status text will report it and the status bar will give you a quick glance at
how much of the file has transferred. If the status bar ever looks like a “barber pole”,
that’s because the action is indeterminate — in other words, Transmit can’t predict when
it’s going to finish, but wants to show you that something’s going on.

Hitting the stop button — the “stop sign” button to the left of the status information —
immediately cancels the operation currently in progress. The stop button does the same
thing as choosing “Cancel” from the “File” menu, or pressing “command-period” (the
“Apple” key plus the period key at the same time).

More Information Switch

Sometimes you’re doing a quickie transfer and want to get your work done with little
distraction. Other times you’re doing some seriously complicated transfers, and need to
know a little bit more about what’s going on. Either way, you’ll want to click the little
arrow to flip down — or up — the “More Information” panel. The arrow acts as a toggle,
hiding and showing the panel with each click.

Expert Interface Tricks

Sort By Date

Transmit also has the somewhat hidden ability to “sort by date”. Simply hold down the
option key and click on the “sort by size” button. Bingo! Your files will now be listed from
newest modification date to oldest modification date. Hitting the “sort order” button will,
obviously, sort in the opposite direction. Option-click the “sort by date” button a second
time to switch back to “sort by size”.

Quick Disconnect

Want to disconnect from a server, pronto!, without closing the window or choosing the
“Disconnect” item from the File menu? Simply hold down the option key and click on the
“Stop” button. You will disconnect from the server and be back at the connection panel.

Reload / Refresh

Has something changed in a file listing since Transmit last loaded the list? Hold down the
option key and click the parent button to reload the file listing.

Keyboard Navigation

For truly hard-core keyboard jockeys, you can use your keyboard to navigate the file
listings in Transmit. The cursor up and down keys to move the highlight up or down, the
page up and page down keys scroll one page at a time, and hitting tab or the left or right
arrow keys will switch the currently active panel. Holding down the shift key while navig-
ating a list will select items. Hitting return over a folder will open the folder; hitting return
over a file will initiate a transfer. Finally, typing the first few letters of a file name will
automatically jump to that file in the list. (See the “Download” section for more informa-
tion on how to select files using the mouse and the keyboard).
**Making A Connection**

Your dad was right — in this world, it’s all about connections. Never has this cliché been more accurate than with FTP. Before you can do anything useful, you’ve got to send Transmit out to connect to another computer (server) and begin talking with it.

**The Connection Panel**

When you first open a new Transmit window or launch Transmit, the “Your Stuff” panel — which usually contains a list of files — is a “connection pane”. It’s basically waiting for you to give it the relevant information it needs to establish a connection. You can type in the information by hand, paste an ftp:// URL from the clipboard, or drag and drop a URL to automatically fill out the fields. When pasting or dragging a URL, it must begin with ftp:// to work properly.

![Login to a Server]

- The **address** field is used to specify the address of the machine you want to connect to. It could be a hostname (i.e. host.domain.com) or an IP address (i.e. 206.105.6.10). If the address requires a specific port setting, add a colon and the port number after the address (i.e. host.domain.com:5353).

- The **username** field is for the username used to login. If the site is anonymous, it’s acceptable to leave this field blank — Transmit will assume you want to login anonymously.

- The **password** field is for your password. Again, leave it blank for anonymous, and Transmit will automatically substitute your E-Mail address. (Sending your E-Mail address automatically is optional — you can turn it off in the preferences for true anonymity).

- The **directory** specifies the UNIX-style directory path to begin with upon connect (i.e. /usr/local/etc/httpd/)

**Favorites**

After a lot of FTPing, chances are you’ll see a pattern start to emerge in the sites you connect to: there’s a lot of repetition involved. The same usernames, passwords, and addresses tend to crop up again and again. Our solution? The time-saver and carpal-tunnel calmer we call the favorites menu.
After you fill out all the required fields to make a connection, simply select “Add This to Favorites...” from the favorites menu. A dialog box will prompt you to name your new favorite. Type in a new name and click “OK”, then go ahead and pull down the favorites menu again. Voila! Your favorite is now tucked away in the menu, and every time you select it all the connection fields will be automatically filled out for you. Naturally, your favorites are automatically saved in a “Transmit Favorites” file in the system’s preferences folder.

If you find yourself no longer frequenting a once-popular FTP joint, select “Delete a Favorite...” from the favorites menu. A list of all your favorites will pop-up: simply highlight the favorite you want to purge permanently, and click “Delete”.

You might have a favorite or two that, for security reasons, you don’t wish to save the password with. This is fine; if you fill in the username but leave the password field blank when creating a favorite Transmit will automatically prompt you for the password when you attempt to connect.

Don’t be fooled by the simple and clean nature of the favorites menu — there’s a lot of timesaving wallop packed under that tiny little button.
TRANSFERRING FILES

It’s possible to teach you everything you need to know about transferring files in Transmit with three words: drag and drop.

That’s it. If you’re used to dragging and dropping all over the MacOS to move files and folders from one place to another, than you have all the training you need to transfer files with Transmit. We’ll explain the basic idea a little more in this section, but don’t forget:

In Transmit, dragging and dropping gets you everywhere.

Downloading

When you download a file, you’re essentially copying the file from a remote server to your local machine.

First, make sure you’ve connected to a remote server by filling in all the necessary fields and hitting “connect”. Then, once you’re there, just click and drag a file from Their Stuff over to the Your Stuff panel. The Your Stuff panel should highlight, and the file will be downloaded to the directory Your Stuff is set to. There’s one exception: if you drag the file over a folder, the folder will highlight and the file will actually be downloaded inside that folder. This is important — if you download files and can’t find them, double-check that they didn’t wind up inside a folder by mistake.

To select multiple items to download, use the shift or command (“apple”) keys. The shift key is used for selecting ranges — in other words, if you click an item, hold down shift, and click an item 7 items down, everything between the first item and the 7th item will be highlighted. The command key is used for selecting individual items as part of a group of files — click the 4th, 10th, and 30th file with the command key held down and they’ll all be highlighted as a member of the same “group”.

Transmit, of course, supports recursive downloading of files and folders. If you download a folder which contains three other folders, each of which contain 5 files, then all the files and folders will be downloaded and the exact structure of what you’re downloading will be reproduced on your computer.
Dragging to and from the Finder (i.e. “finder drags”) is also possible and, in some cases, really useful. In other words, your drag and drops aren’t just limited from Your Stuff to Their Stuff — you can select multiple items from Their Stuff and drag them onto of the Finder’s desktop or in a folder on the desktop, etc.

**Uploading**

Uploading works exactly the same as downloading, except in the opposite direction — from Your Stuff to Their Stuff.

If working from the Finder, you can also select files on the desktop, in a folder, etc. and drop them on top of Transmit’s Their Stuff pane to upload them.

**Duplicate Files**

Throughout all of your uploads and downloads, you’re bound to encounter a duplicate filename. Let’s say you’re uploading the file “CashTown.gif” into a folder named “Money”, but there already happens to be a file with that name in that folder. What happens?

![Duplicate File Dialog](image)

That’s what happens. What we call the “duplicate dialog”. Assuming you haven’t mucked with your preferences yet, Transmit will pop-up this dialog, nicely asking you for the correct course of action. You can:

- **Overwrite.** This will effectively delete the file that exists already, and replace with the file you’re about to transfer.

- **Rename.** This will keep the existing file intact, and rename the file you’re about to transfer. If you were transferring “CashTown.gif”, your file would instead be named “CashTown.gif.1”, to keep it distinct from the file that exists.

- **Resume.** This will continue your transfer where you left off, if possible. If not possible, this button will not be available. (Resuming will be discussed a bit more later)
• Cancel your transfer — and any other files in your batch.

The “Do this for all other duplicates” checkbox allows you to set a precedent for the remaining files in the current transfer. If you were transferring 8 files, 4 of which being duplicates, and you wanted all of them to be overwritten, you would check the “Do this for all other duplicates” checkbox before hitting the “Overwrite” button. Then, all other duplicates in that particular batch transfer would be overwritten automatically without your intervention. Use with caution!

If you find yourself always clicking the same button when the duplicate dialog pops up, you should set a default behavior for it in the preferences to save you a whole lot of clicks. This is covered in more detail in the preferences chapter of this guide.

**Resuming**

So, you were 34 megabytes into downloading the latest 60 megabyte archive of ReallyBigBrowser V14 beta 3 when your cat decided to play “pounce-the-power-strip”, bringing your computer from 60 to 0 in one terrifying second. What now? Yes yes, tell the cat she’s been naughty, but what then? Start the entire transfer over from scratch?

Not unless you suffer from masochistic tendencies. All you have to do is relaunch Transmit, connect to where you were connected to, and drag the file to the same location that the partially-downloaded file was living. When you get the duplicate dialog (above), click the “Resume” button. Transmit will automatically pick up your transfer right where it left off, saving a whole heap of time. It’s also important to note that Transmit can resume hours, months, or years after the transfer has been interrupted — it doesn’t have to be in the “same session” like other FTP programs.

Here’s a little behind-the-scenes understanding: when determining if a file can be resumed, Transmit compares two things: the filename, and the file size. If you’re downloading a file named “bob.gif”, and there’s a file named “bob.gif” where you’re dragging the file to, then the first resuming flag is raised. If the size of the existing bob.gif is smaller than the one you’re dragging, then the second resuming flag is raised, because we assume the smaller size is a result of an interrupted transfer. When both flags are raised, the resume button is active.

Ultimately it’s up to you to decide whether a file should be resumed or not. We can only do so much in predicting the state of the file! Of course, if “bob.gif” has changed completely on the server since you last tried downloading it, resuming the file will only merge two different chunks of data, rendering a rather unusable file!

Of course, as will all things good in this world, there’s one caveat: the server you were connected to must support file resuming. If it doesn’t, the resume button won’t be available, but most modern servers should be just fine.

(Resuming works with both uploads and downloads, by the way.)
WORKING WITH FILES

So now you’ve got the basics: you know how to upload and download, and you can do it with the best of them. You can zing files to your desktop, drag folders from your hard-drive in mass volumes, and resume like you’re a seasoned pro.

But, somewhere deep in your soul, an unknown essence begs for more: “Surely”, you think, “there must be a higher meaning. A little more substance to all these FTP goings-on.” Well, your soul was right: there’s a whole lot more you can do with files via FTP!

And that’s the end of this manual. Thanks for reading!

Just kidding. Naturally we’re going to explain it all for you! Sit back, relax, and learn a bit more about working with files.

Renaming Files

If you’ve ever renamed a file or folder before in the MacOS, you can do it in Transmit — it works exactly the same. Simply click on the item you wish to rename, then leave the mouse still — don’t hold down the mouse button — and wait a couple seconds. The item’s highlighting will turn into an text input box, all ready for you to provide it with a new name for that item! Type in the new name for the item and hit “return” (or click elsewhere) to rename it.

If you’ve got the rename box by accident and didn’t really intend to rename anything, just ignore it and go one with your business — the file won’t be renamed.

Remember, both local and remote files can be renamed.

Deleting Files

Hello, Mr. Trashcan! Tucked nice and neat in the lower right hand corner of the Transmit interface, Mr. Trash has but one purpose in life: to eat and destroy your files and folders. But he needs your assistance to perform his only task! Simply drag and drop your files and folders on top of the trashcan to delete them. Both local and remote files can be deleted in this manner.

Alternatively, you can drag and drop files to the trashcan in the Finder (most likely in the lower-right hand corner of your monitor).
Moving Files

It’s all right if you uploaded some items where they weren’t supposed to be — you don’t have to be ashamed. Fortunately, it’s really easy to move items around without having to re-transfer them.

If you’re working with Your Stuff (local files), you can select items and drag and drop them into other folders in the Your Stuff list. Or, you can drag and drop them into folders, hard drives, or any otherimaginable location in the Finder. Alternatively, you can open a second Transmit window, set the location of the second Your Stuff, and drag and drop files from one window’s Your Stuff to another window’s Your Stuff.

With remote files, the same drag-and-drop principle applies. You can drag and drop files from Their Stuff into other Their Stuff folders. Or, you can select item(s) and use the “Move Items To...” menu choice (under “File”) to type in a specific path that you want to move all the items to.

As a side note, it’s not possible — yet — to move items from Their Stuff to Their Stuff, i.e. from one server to another. The FTP protocol used to support this, but it has since been removed for security reasons on virtually all servers.

Learning More About Files

Just like in the MacOS (see a pattern here?), you can use the “Get Info” menu choice when items are highlighted to learn a whole lot more about the particular items, including modification date, location, owner, and group.

Setting Permissions on Files

You might have noticed the “Permissions” corner tucked away in the “Get Info” window of remote files. If you didn’t, try selecting a remote item and choosing “Get Info” from the menu. Setting the permissions on files control which types of people can access the files, and what kind of access they have. When we say people, we’re referring to the other users on the server you’re connected to.
Permissions are generally only tweaked by expert users. If you aren’t familiar with permissions, or haven’t been instructed to set them by your web hosting service or internet service provider, chances are you needn’t bother with them. But if you do need to set them, the Get Info window makes it easy: just check the relevant boxes to control who can do what with your file.

The boxes are laid out in grid formation. When setting the permissions of the files, follow the grid’s order. For example, if you wanted to make your file readable by the world, you would check the box under both the “world” icon and the “glasses” icon, like in the screenshot above.

**Synchronizing Files**

If you maintain a web site, prepare a software mirror, or otherwise frequently maintain remote files, you’ve probably needed to synchronize — match or mirror remote files to local files on your hard drive.

But chances are, you either did it painfully by hand, (the “eenie-meenie-miney-moe” system), shouted across the room to co-workers to figure out which files to upload (the “heyPhilwhatsthelatestheaderpic” system), or tried to hand-synchronize files and lost some really important files during the process (we can’t print the name of this one). By using Transmit’s built-in synchronization system, you can easily keep remote and local files up-to-date with little effort.

The first thing you need to do when synchronizing two directories is load both directories in their respective panes. For example, if you want to sync the contents of a folder named “www” on your desktop with a remote machine’s directory named “/home/www/”, make sure the “www” directory is loaded in “Your Stuff” and you’ve connected and loaded the “/home/www” directory in their stuff.

Once your source and target directories are in place, you’re ready to synchronize. Choose “Synchronize...” from the “File” menu to get the synchronization dialog box.
First, you need to choose a synchronization type: update or mirror.

- The **update** method of synchronization simply looks for files in the target directory whose modification dates are older than the files you are transferring from the source directory, and replaces those files with the newer files.

- The **mirror** method of synchronization not only compares modification dates and replaces older files, but also deletes files that exist on the target directory but don’t exist in the source directory. This makes the target directory a “mirror” of the source directory by deleting files that no longer exist.

Then, you need to choose a synchronization direction: **upload**, which synchronizes their stuff to match your stuff, and **download**, which synchronizes your stuff to match their stuff.

Click the “Go” button and Transmit will be off on its merry way — exploring and cataloging directories, uploading and updating relevant files, and deleting old files (if chosen). Sit back and relax as Transmit tirelessly does the dirty work! At the end, Transmit will present a summary of how many files were transferred and deleted during the synchronization.

There are a few important notes about synchronization. For starters, Transmit compares a file’s timestamp — the date and time the file was modified or created — in order to decide which files to update. One potential hazard could be working with a fileserver in a different timezone. Say you work in San Francisco but your web host is in New York. If you’ve uploaded a file at 2:00, then updated it at 3:00, chances are Transmit won’t consider it “new” because the timestamp on the remote file uploaded at 2:00 is 5:00 — eastern standard time. If you don’t find yourself needing to synchronize files every three hours, and usually only synchronize daily, working with a server in another timezone should be no problem. But if strange behavior occurs during synchronization, always check this first.

The other important note is simple: be careful. Although we warn you before synchronizing, remember that you’re telling Transmit to automate some tasks that could potentially cause you to lose data due to unforeseen operator error. Be cautious.

Synchronization is an unbelievable time-saver. Stop doing things the hard way, and let your Macintosh do some of your work for you!
**Reading Files**

With certain remote files — error logs, for example, or tiny READMEs — you might find yourself wishing for a way to quickly read the file without having to leave Transmit, switch applications, and download the particular file. Wish no more.

If you select a remote file and choose “Read Remote File” from the “File” menu, a text window will open, the file will download internally, and the contents of the file will be displayed in a window when the file has finished downloading. Quick, easy, simple.

Be careful not to choose “Read Remote File” on binary (non-text) files, because all you’ll get is a lot of gibberish. Additionally, be cautious not to “Read” extra large files, as you may find yourself running out of memory.

**Creating Folders**

Just like in the MacOS, creating new folders — both remote and local — under Transmit is a piece of cake. Simply choose “New Folder...” from the “File” menu. You’ll be presented with a dialog box that looks like the following:

![New Folder dialog box](image)

Simply choose where you want the new folder to appear, and give the folder a name. Clicking “Make” will create the new folder in a flash.
EXTRA CREDIT

Transmit is a very powerful program. And as a result, there are a number of features tucked away in nooks and crannies. Here are some of them that may be of interest to you.

**Graphic Preview**

Designed to offer an easy, instant means of previewing local graphic files, you’ll never know just how handy the graphic preview can be until you give it a whirl. How many times have you stared blankly at a list of .gif’s ready to be posted to your web site, wondering just what the difference between “a45-header.gif” and “b45-header.gif” is? You need the Preview Window.

Simply select “Graphic Preview” from under the “Windows” menu, and the preview floating window will open above all other windows. Drag local graphic files on top of the preview window and a small preview will display.

If you have Quicktime 3 installed, you will receive a preview for any graphic file Quicktime can recognize. Transmit will also display the dimensions of the graphic in the title bar of the preview window. If you don’t have Quicktime 3 installed, you’ll only see a preview for files that have been saved with a built-in preview, such as Photoshop documents.

**Transcript Window**

If you’re a Unix junkie, troubleshooter, or just like knowing how things work under the hood, opening the transcript window will allow you to see the inner workings underneath Transmit’s glitzy interface.

Open the transcript window via the Windows menu. As you work in Transmit, the FTP commands and responses sent and received between the FTP server and Transmit will be displayed inside the transcript window. You can copy and paste text from the transcript window. Often, when you log in to servers, “welcome banners” are displayed to give you general information about the site. Since Transmit doesn’t display these often unnecessary messages to you, pop open the transcript window to view them. Additionally, when troubleshooting an FTP problem like an unknown error, the transcript window is the best place to look to see what’s going on.
**Contextual Menus**

As a new feature of MacOS 8, contextual menus have captured the hearts and minds of countless efficiency-seeking Macintosh users. A shortcut method of accessing menus and performing basic tasks, contextual menus are handy because they’re a mere keyboard-and-mouse click away from where you’re working — no more needless trips to the menu-bar or far-reaching drags and drops.

Transmit, naturally, supports contextual menus. To see them in action, highlight an item or two in a file list, then press and hold down the control key. You should see the mouse cursor change to reflect the availability of contextual menus. Simply click the mouse and voila! A pop-up menu of available actions you can perform on the selected file appears.

Naturally, the available menu options vary depending on the kind of file you’re working on. Local files can be encoded as MacBinary but remote files cannot, etc. So before you scratch your head wondering why a specific menu option is disabled, make sure the menu option makes sense on that particular highlighted item.

**Finder Icon Progress Bars**

As a surprisingly handy feature, Transmit can add progress bars to the Finder icons of downloading files. In other words, without even having the Transmit window in the foreground, you can glance at the finder to see how much of your file has already been transferred. Transmit updates this progress bar in 10% increments. Neat!

**Using URL’s**

Got an FTP address in an E-Mail or as a link on a web site? Transmit will happily accept it through drag and drop. Moreover, you can drag remote files from Transmit to drag-and-drop aware applications which will insert URL’s. Don’t worry, we’ll elaborate.

**To Transmit**

As a simple example, say someone sends you an E-Mail that has a link to a place where
you can download LinkPad, which they say is a really cool program. Ahem. The text would look something like the following:

Hey, you should check out the following Mac freeware:
ftp://www.panic.com/pub/LinkPad_1.0_PPC.sit.bin -- it’s pretty darn handy.

Spot the URL? (If you’re a beginner, the ftp:// line, up to and including the .bin, is a URL — a uniform resource locator. It’s a internet address that contains everything necessary to connect to an FTP server in one sentence). If you wanted to use Transmit to download this file, all you’d have to do is highlight the text of the url — “ftp://www.panic.com/pub/LinkPad_1.0_PPC.sit.bin” — and either drag the text on top of a Transmit window’s connection pane or copy and paste it into Transmit’s connection fields. You’ll notice that Transmit automatically fills out all the connection information for you — just click “Connect” and you’re on your way and downloading that file.

Transmit can accept any FTP URL drags. You could drag ftp:// links from a web page. You could drag ftp:// URL’s from LinkPad. You name it. When pasting or dragging a URL, however, be careful that it starts with ftp://. Otherwise, Transmit won’t be able to recognize it.

From Transmit

Now, what about the other way around? Say you’re browsing an FTP site, you come across an interesting file, and you want to point your friend to that file?

Assuming you’re using a drag-and-drop aware E-Mail application such as Eudora™, simply drag the file of interest out of Transmit’s “their stuff” view and onto the window with the E-Mail you’re writing. The complete FTP URL will automatically be inserted into your message.

You could drop these Your Stuff files onto Stickies or Note Pad to make a note of them. You could drop them in Microsoft Word documents. Just be careful not to drop them onto the Finder or the desktop — that’ll download the file, silly!

Files & FileTypes

Can’t launch your downloaded files with the right application? Having trouble sending Text Files to a UNIX system without them getting a little nutty? It’s all a matter of processing, my friend.

File Mapping

A little background: we all know that Macs are often far more intelligent then their Windows-ian brothers; never has this been more evident with the MacOS and file association. With the MacOS, when a file is saved from, say, SimpleText, the MacOS allows a special flag in this file to set the “creator” and “filetype”. In short, this means that your SimpleText file will always be associated as a text file that was created in SimpleText. If you move this file to another machine, as long as it has SimpleText the file will launch without issue when you double click it.
Windows — and UNIX — don’t have such a handy feature. They rely on the three letters at the end of a file to determine who created it. That’s why you’ll see PC programs like “document.txt” or “program.exe” — the .txt indicates the program is a text file, and the .exe indicates it’s a program. The problem with this approach? Delete the three letters at the end, and the file is forever disassociated. The file’s owner is lost, and the file can’t be used with a simple double-click anymore.

The MacOS approach, while superior, has one small problem: not every computer in the world is a Macintosh. (Yet.) So what happens when you download a graphics file created on a PC named “graphic.psd” to a Macintosh? The Mac, without its special association built into the file, is lost.

You saw it coming: file mapping to the rescue! File mappings allows the Macintosh to associate a three letter extension (i.e., “.psd”) with a program (i.e., “Photoshop”). That way, when you download a file from a foreign operating system, the Macintosh will look up the extension in a table and, if it finds it, will automatically set the filetype for you. You can then double-click the file with joy — it’ll do just what you’d expect.

Fortunately, as of MacOS 8.5 (or if you have Internet Config), your system comes preconfigured for most of the filetypes floating around out there. But if you come across blank document icons, meaning that a filetype isn’t properly configured, mapping a file is easy! Let’s say you want all the files you download with the “.txt” extension to be associated with SimpleText. Here’s how you’d do it under MacOS 8.5:

1. In Transmit, choose “Preferences…” from the “Edit” menu.
2. Click the “Edit File Mappings” button on the “Transfers” tab. The Internet control panel will open.
3. Click the “Add” button at the bottom of the file mappings list.
4. Type “.txt” (without the quotes) into the “Extension” box.
5. Scroll down the list of applications until you see “SimpleText”. Click it.
6. Finally, because you know you want these files to be text files, scroll down the “File type” list until you see the document icon (with type “TEXT”).
7. That’s it! You’re done. Now when you download files with “.txt” at the end Transmit will automatically set them to SimpleText files!

If you’re not using MacOS 8.5, the process will be quite similar: however, instead of choosing “SimpleText” from a list of applications at step 5 you should hit the “Choose Example…” button and choose another SimpleText text file on your hard-drive. Then you can skip step 6.

That’s it! May your files forever open with the right application!
Text Files / ASCII Mode

There's one other cross-platform gotcha to keep an eye out for — mangled text files. You see, the Macintosh creates its text files with a certain set of hidden characters at the end of each line. Other platforms, however, expect a different set of characters at the end of a line. The end result? (Often text files created with a Macintosh have strange, extra character when viewed on a UNIX machine, and as a result run together on one line.) Worse yet, scripts created with a Macintosh text editor may fail to function when uploaded to a UNIX machine.

Fortunately, Transmit can help. If you're transferring a text file that was created with Macintosh linefeeds, you can turn on “ASCII Mode” under the “File” menu before the transfer. This will cause Transmit to automatically translate the Macintosh linefeeds into cross-platform ones. Be careful, however, to turn off ASCII mode when you transfer graphics or binary files — otherwise these files will wind up corrupted when transferred.

If you find yourself turning on ASCII mode often, you can have it automatically turn on when files of a certain type are uploaded. The steps to set this up are simple, as this example for MacOS 8.5 explains:

1. In Transmit, choose “Preferences...” from the “Edit” menu.
2. Click the “Use Internet prefs to set transfer mode” radio button for uploads and/or downloads. This tells Transmit to pay attention to your Internet settings to decide if ASCII mode should be turned on or not.
3. Click the “Edit File Mappings” button on the “Transfers” tab. The Internet control panel will open.
4. Click on the file type you wish to have automatically sent as ASCII mode.
5. Click on the “Change...” button.
6. Click on the “Show Advanced Options” button.
7. Click the default format: button of your choosing — in this case, “Plain text”.

If you're not using MacOS 8.5, you can skip steps 6.

That's it! Now, when Transmit comes across the file type you've specified, it will automatically turn on ASCII mode before beginning the transfer.

Troubleshooting tip: if you use ASCII Mode often, and find yourself uploading graphics and other files that appear corrupted when viewed, make sure that you've turned off ASCII Mode before transferring these files. ASCII Mode should only ever be turned on if you're uploading Macintosh-created text files.
Experts take note: Transmit fully supports AppleScript for simple automation of Transmit. For example, you could write an AppleScript to automatically download a server logfile at 3:00am every day and you wouldn’t have to be present at the computer to make it happen. Moreover, by using a AppleScript interface front-end such as FaceSpan or RealBasic, you could even write utilities that expand Transmit’s power by controlling Transmit “remotely”.

About AppleScript

AppleScript harnesses and extends the power of Apple Events, a system designed to get applications to “talk” to other applications.

If you’re not familiar with AppleScript, there are a whole host of tutorials, books, and example scripts that can get you started on the Internet and at your local bookstore. We recommend first peeking inside the AppleScript folder that’s probably been installed in the “Apple Extras” folder of your hard-drive. This folder contains the script editor — used to write AppleScripts — and a handful of sample scripts.

Transmit’s Dictionary

Please note that for Transmit to recognize your AppleScript commands, you need to be “telling” them to a particular window. See the example script for how we think you should do this.

Connect

**Usage:** connect to [server] as [user] with password [password]
**Ex.:** connect to “ftp.foo.com” as “cabel” with password “donkey”

Before you can do anything meaningful with Transmit through AppleScript, you’ve got to connect to a server. Use the “connect” command to do so. You can optionally supply a username and password to the connect argument to login to a specific account. If you don’t want to include a password in the script, leave it out and you will be prompted upon connection for a password.

Set path

**Usage:** set path of [your stuff|their stuff] 1 to [path]
**Ex.:** set path of their stuff 1 to “/www/pics/”

Set the path of their stuff and your stuff to indicate where to transfer files and where they should be transferred to. Both “Their Stuff” and “Your Stuff” can be set. “Their Stuff” uses common UNIX paths. “Your Stuff” uses AppleScript-style Macintosh paths (i.e. “Cleo:Utilities:Filename.sit”). The number “1” after the specified stuff is required.
Download

Usage: download [folder|file] [name]
Ex.: download folder “Big Pictures”

The “download” command initiates a download of the file or folder “name” from the their stuff directory previously set with the “set path” command.

Upload

Usage: upload [file|folder] [name]
Ex.: upload file “path:to:folder:bigbelly.sit”

The upload command initiates a transfer of the file or folder “name” to the “their stuff” directory previously set by the “set path” command. Use colons to pass a path; for example, if the file is on your drive named “Bob” in a folder named “Joe”, you could use the name “Bob:joe:thefile.txt”.

Delete

Usage: delete [file|folder] [name]
Ex.: delete file “hungryman.sit”

The delete command, naturally, deletes a file or folder. Careful with this one — there is no undo.

GetURL

Usage: geturl [URL]

Most Internet applications share the GetURL Apple Event — a quick and easy way of fetching URL’s. For example, if you have Netscape configured to use Transmit for FTP, and you click a ftp:// link in Netscape, Netscape sends Transmit a GetURL event which sends Transmit off on its merry way. When you send a GetURL to Transmit, Transmit opens a new window, fills out the connection pane with the information contained within the URL, then establishes a connection and downloads the file (if applicable) to the currently Your Stuff location.

Synchronize Upload

Usage: synchronize upload

This short AppleScript command will begin a synchronization of the remote files to match the local files. Files that are newer on the local side will be uploaded to the remote side to bring the remote side up-to-date. Make sure you have “their stuff” and “your stuff” set to the proper directories you wish to synchronize!

Synchronize Download

Usage: synchronize download
This command will begin a synchronization of the local files to match the remote files. Files that are newer on the remote side will be downloaded to the local side to bring the local side up-to-date.

**Mirror Upload**

**Usage:** mirror upload

This command will begin a mirror of the remote files to match the local files. Files that are newer on the local side will be uploaded to the remote side, and files that don’t exist on the local side will be deleted from the remote side.

**Mirror Download**

**Usage:** mirror download

This command will begin a mirror of the local files to match the remote files. Files that are newer on the remote side will be downloaded to the local side, and files that don’t exist on the remote side will be deleted from the local side.

**Example Script**

Here’s an example script that connects to the server “ftp.panic.com” and downloads LinkPad into the “Utilities” directory of the local user’s hard-drive named “Cleo”. See if you can follow along!

```applescript
tell application "Transmit"
    set theWindow to make new window

    tell theWindow
        set path of your stuff 1 to "Cleo:Utilities"

        connect to "ftp.panic.com"
        set path of their stuff 1 to "/pub"

        with timeout of 600 seconds
            download file "LinkPad_1.0_PPC.sit.bin"
        end timeout

        close
    end tell
end tell
```

For another example, see the “add - upload files” folder action AppleScript in Transmit’s Goodies folder.
Preferences Explained

Transmit’s preferences, accessible under the “Edit” menu, allow you to customize your Transmit experience. The preferences window is split into four “tabs” — separate panels of preferences. Click on each tab to switch between the panels. When you’re done setting your preferences, click the “Save” button to apply and save your settings. There are a whole host of options available under preferences that affect the program’s operation — we’ll cover them all here!

Files

The files tab covers most file-related preferences.

Show exact file sizes
Checking this box displays accurate file sizes as opposed to the standard, MacOS-style display sizes. For example, a file size displayed as “1.3M” (1.3 megabytes) might be displayed as “1,418,053” with exact file sizes.

Hide files beginning with “.”
On most Unix systems, items beginning with a period (like “.cshrc”) are considered “hidden”. However, some power users need to work with these items. Unchecking this box will display all files, period or no period.

Always ask before deleting things
Traditionally, Transmit displays an alert box double-checking that you want to delete a file. Unchecking this box will remove this last-chance warning. But be careful: you’ll have no-one to blame but yourself!

Initial “Your Stuff”
When a new window is opened, you can define the initial directory shown in “Your Stuff” in one of two ways. You can use the download folder defined in your Internet preferences (the first radio button), or you can specify a directory by selecting the second radio button and clicking the button to the right of it. A dialog box will open allowing you to select a folder, and this folder will become the default initial “Your Stuff” folder.

Edit File Mappings
As described in the “Files & File Mappings” section, click this button to be taken to the appropriate place to set your file mappings. File mappings determine how filename extensions (“.txt”) should be associated with programs (“SimpleText”).

Auto set uploaded permissions to...
If you’re uploading a whole host of files — say, to maintain a web site — and you want every uploaded file to be readable by all, this is your chance to set it with little effort. Simple check the “Auto set...” checkbox and then set the permissions to your preferred default settings. When files are uploaded, Transmit will automatically change the permissions on each file. Your server must support this feature, however, in order for it to work.

Transfers
The transfers tab contains most transfer-related preferences.

**Beep when [transfer] is complete**  
Checking this box will cause a system beep to blurt out when a transfer is finished.

**Post-process files when possible**  
If you have Internet Config or MacOS 8.5 installed, then checking this box will send downloaded files to the “helper application” specified in Internet Config’s file mapping preferences. For example, if you tell Internet Config to send all files with a suffix of “.sit” to StuffIt Expander, after Transmit downloads the file “jimmy.sit”, it will automatically send the file to StuffIt Expander for post-processing. If no helper application is mapped to a particular suffix, no post-processing will take place.

**Use Internet prefs to set transfer mode**  
As described in the “Files & File Mappings” section, this preference makes Transmit check your file mapping settings to determine which files should be transferred with “ASCII Mode”.

**When identical filenames are encountered...**  
This setting determines how Transmit will behave when you try to transfer a file that already exists at the destination. The first option, “Ask me what to do”, will cause Transmit to open a dialog box allowing you to make this decision on a per-file or per-batch basis. The second option, “Overwrite the existing file”, will cause Transmit to overwrite the existing file with the new file. While this can dramatically decrease batch upload times, you should be careful when using it. With the third option, “Use a new but similar name”, Transmit will rename the file you’re uploading by adding a numbered extension at the end. For example, if you’re uploading “thegraphic.gif” and that file already exists, Transmit will name the file “thegraphic.gif.1”. Finally, “Try to resume (then ask if not possible)” will cause Transmit to attempt a resume if the destination file size is bigger than the source file size. If Transmit cannot resume the transfer, it will prompt you for a decision.

**Don’t filter filenames**  
Transmit is careful when uploading files by default — if it finds a character in a filename that may cause trouble with a server, it will replace it with a “safe” character. If this is causing trouble for your files — you are expecting the filename exactly as written with no substitution — check this box. It will turn off Transmit’s filtering system.

**Network**  
If it has to do with network settings and connections, it’s here.

**Redial busy servers every...**  
Trying to connect to a really busy server? Some servers only allow a certain number of anonymous connections at one time. Really popular servers can be downright difficult to connect to. After clicking this box and setting a redial time, Transmit will automatically redial a server if told the server is full. Obviously, a smaller redial time means the site will be redialed more often.
Upon opening window, immediately select...
If you have a particular site you tend to connect to often — and you have a favorite already set for said site — check this box and select that favorite from the pull-down menu. When you open a fresh Transmit window, Transmit will automatically fill in the connection information for the site of your choosing. (To automatically select to a particular site, you must first add it as a favorite.) See the “Favorites” subsection of “Making A Connection” for more information.

Immediately connect when favorite is selected
Usually, when you select a favorite from the favorites menu, Transmit just fills out all the necessary connection information and leaves it up to you to make and necessary changes and click the “Connect” button. With this option selected, Transmit automatically clicks the “Connect” button for you. In other words, immediately after you choose a favorite Transmit connects to that particular favorite. This also affects the above preference setting; if you have a favorite automatically selected when a window is opened and have this box checked, Transmit will automatically connect to that server when a window is opened.

“Tickle” servers to keep connections alive
Many servers have a “timeout” function that boots you off the server after a predetermined period of time. To get around such a timeout, check this box. Transmit will automatically “Tickle” (send a periodic message) the server to avoid the timeout and keep you connected. As a side note, servers have a timeout feature for a reason: many servers are very busy and don’t want loafers lounging about. So, tickle responsibly! (Some servers can’t be fooled by a simple tickle.)

Proxy Servers
If you’re not familiar with proxy servers, chances are good you don’t need one. However, if your ISP or corporation uses firewalls, you’ll probably need to set Transmit to use these firewalls in order to see the outside world. The relevant information should be provided by your ISP and/or network administrator, and it should be easy to configure Transmit based on these setting — just check “Use a proxy server” and enter the relevant proxy server address. Alternatively, you can use your Internet prefs’ proxy settings to keep your information in one place. If your proxy server is an “authenticating” proxy server — requiring a username and password — select the Internet prefs option, and fill in the proxy server username and password in your Internet prefs (the Internet control panel under 8.5, or Internet Config otherwise.) Note: only certain proxy server types are supported at this time.

Misc

Need to tweak the nitty-gritty Transmit details? Stop here.

Show “more information” by default
Checking this box will automatically “expand” the “more information” panel when you open a new window.

On startup open preview window
With this checked, the preview window will automatically open when Transmit is launched.
On startup open transcript window
Again, click this to have the transcript window open when you launch Transmit.

Use generic icons in file lists
If you want to speed up directory gathering and display when you move from one
directory to another, check this box. You won’t get the nice and pretty custom icons in the
file lists, but directory loading speed may increase significantly.

Show “Their Stuff” only
One of Transmit’s best-kept secrets, checking this box drastically slims down the interface
by removing the “Your Stuff” view. If you find yourself dragging things mainly to and
from the finder — or if you’re slim on screen real-estate — check this box. Your next new
window will be their stuff only.

Use progress bars in Finder icons
As a spiffy bonus, Transmit has the ability to build progress-bars into your Finder-based
icons (see the “Finder icon progress bars” subsection of “Extra Credit” for more informa-
tion). However, with small transfers or fast network connections, this feature is not as
necessary and useful as with slower connections and larger files. If you want, uncheck
this box to disable this feature and have plain-old Finder icons during a download.

Double-clicking files initiates transfers
As another useful trick, it’s possible to instantly ship single files off to upload or download
by simply double-clicking them. If you’ve got a clumsy mouse hand and this leads you
into accidental transfers, uncheck this box to disable this feature.

Always highlight the active panel
If you navigate via the keyboard often in Transmit, checking this box will keep the “focus
ring” — the colored box determining which side is being controlled by the keyboard —
always on.

Use FCCM™ (Fetch cursor-compatibility mode)
It seems quite a few of you have grown attached to that running dog.

Anonymous Connect
These two radio buttons determine what should be sent when you connect to an anony-
rous FTP server without providing a password. Traditionally, anonymous FTP servers
require your E-Mail address as a password. When you leave the password field blank in
the connection pane — which is fine — Transmit needs to send something as a password
to satisfy this requirement. Clicking “Send my Internet Config E-Mail address” will send
the E-Mail address you have defined in Internet Config. Clicking “Send user@host.com
as my E-Mail address” will do just that — send the text “user@host.com” to satisfy the
server’s need for an address. (This is a more anonymous option).

Register Transmit as Netscape’s FTP Helper
Clicking this button will tell Netscape to send any clicks to ftp:// URL’s over to Transmit.
Transmit will then initiate the download. Handy.

Unregister Transmit as Netscape’s FTP Helper
…but even the handiest things can sometimes get old. Click this button to undo the
registration, causing clicks to ftp:// URL’s in Netscape to be handled internally by
Although most everything in Transmit can be accomplished via drag and drop, there are a few times you’ll have to venture into the wide world of menus. In this section we’ll dissect every available menu choice so no mysteries are left standing.

**Apple**

**About Transmit...**
If you’re curious how to contact Panic, who made the program, and other precious nuggets of knowledge, choose About Transmit... and be on your way.

**File**

The bulk of Transmit’s menu options are under the file menu — files are our specialty. See the “Working With Files” section of the manual for more information on many of these items.

**New Window**
Opens a fresh, clean Transmit window/connection, waiting to be used.

**Close Window**
Closes the current active (frontmost) Transmit window.

**Clone Window**
While connected to a site, choosing “Clone Window” will create a new window at the exact location of your current window. This is handy if you’ve initiated a transfer but want to transfer more items from the same location while Transmit is busy — simply clone the window and start another transfer.

**Disconnect**
Disconnects the current connection and brings you back to the connection panel.

**New Folder...**
As described in “Working with files”, New Folder lets you create remote or local folders.

**Get Info**
Select item(s), both remote and local, and choose “Get Info” to get more information about the particular files.

**Move Items To...**
Select remote item(s) and choose “Move Items To...” to quickly move the items out of their current location and to another location. Move Items To works with both files and folders. Move Items To... accepts standard Unix style paths (i.e. “/usr/local/home/cabel/”, etc.)
**Change Path...**
As a quick and easy way to change remote paths, simple select “Change Path” and input the remote path you wish to move to. This is particularly handy for directories far removed from your current directory. Change Path accepts standard Unix style paths (i.e. “/usr/local/home/cabel/”, etc.)

**Send FTP Command...**
Used for sending raw FTP commands to a server — if you don’t know why you’d need to do this, you probably don’t, but some FTP servers require you to send special commands that Transmit doesn’t know about.

**Add Path to Favorites**
Creates a new favorite with the current location of “their stuff”. A good way to make a favorite to a site while connected to it.

**Read Remote File**
Select remote item(s) and choose “Read Remote File” to view the file locally without having to leave Transmit. (The file will be downloaded, and the file will be displayed in a new window.)

**Synchronize...**
With your mirrored “Your Stuff” and “Their Stuff” directories loaded in their respective panes, choose “Synchronize...” to synchronize the files between the two locations.

**Decode MacBinary File**
Select local item(s) and choose “Decode MacBinary File” to decode files that have been encoded using the MacBinary format. Traditionally, these files end in the extensions “.bin”. You’ll often find these files on remote file archives. This menu option gives you quick-and-easy access to decode files that have been downloaded. Technically speaking, the MacBinary format combines the data and resource forks of Macintosh files into one flat file. Decoding these files splits the two up and creates a usable, often double-clickable Macintosh file.

**Encode As MacBinary**
Select local item(s) and choose “Encode As MacBinary” to encode files into the MacBinary format. This is never necessary if you are uploading graphics such as .gif’s and .jpg’s, and is rarely necessary if you are uploading Macintosh files that have been stuffed with Stuffit Expander (which usually end in .sit). However, if you need to upload a Macintosh executable — say, a file you usually double-click to launch like the calculator — it is usually important to encode the file as MacBinary before you send it to another person. Technically speaking, encoding these files combines the data and resource forks to create a single, flat, Unix-friendly file.

Transmit uses the latest, greatest MacBinary III standard to encode files. This ensures that your Macintosh files retain some newer attributes such as icon badges and routing information. MacBinary III is fully backwards compatible with older version of MacBinary. However, if you’re sending a lot of files out of MacOS 8.5, its best to make sure that the recipient is also using a MacBinary III-compatible decoder.
**ASCII Mode**
As described in the “Files & Filetypes” section, this turns on linefeed translations for your transfers so that Macintosh linefeeds are turned into more Unix-compatible ones. Use this if uploading text files created in, say, SimpleText, to a Unix server.

**Cancel**
Choose “Cancel” to abort any currently pending operation such as a connection or a file transfer. Clicking the cancel button would do the same thing.

**Quit**
Exits Transmit. All open connections will be closed and active transfers will be aborted.

**Edit**
The Edit menu is an Apple-mandated menu that should be familiar to you.

**Cut**
Chose this to “cut” text and add it to the clipboard. This is rarely used in Transmit with the exception of text-input fields in the connection pane, etc.

**Copy**
Choose this to “copy” text to the clipboard. Again, this is rarely used in Transmit.

**Paste**
Choose this to “paste” text from the clipboard into Transmit. This is usually used to paste text such as URL’s and directories into text input boxes in the connection pane.

**Clear**
Use this to delete selected text without adding it to the clipboard.

**Select All**
Use this to select all the files in the currently active list.

**Preferences...**
Choosing this opens the preferences window, which allows you to set a plethora of options controlling the operation of Transmit. Refer to the preferences section of this manual for more information.

**Purchase (Demo Only)**
If you are using the demo version of Transmit, this menu will allow you to legitimize your copy of Transmit by purchasing it. Which is the right thing to do.

**Purchase Transmit On-Line**
Selecting this menu choice will send your web browser (as defined via your Internet preferences) to the Transmit buy page, where you can buy a copy of Transmit instantly on-line. And for a very low price. After your purchase is complete, you’ll be given a serial number which you will use to “unlock” the program out of its demo state.
**Sign up for Transmit eList**
As a service to our customers and friends, signing up for the Transmit eList places you on a mailing list that automatically receives a note when new versions of Transmit are released. It’s the best way to keep your software up to date with little effort, and we promise we won’t sell your name or spam you!

**Enter Serial Number...**
After you have your serial number from purchasing Transmit, choose this option to enter it and unlock Transmit. And thanks!

**Windows**

The window menu is your key to window management.

**Transcript**
To open the transcript window — which contains the under-the-hood FTP commands used to make Transmit work — choose this menu choice.

**Graphic Preview**
To open the graphic preview window — which allows you to preview local graphics files — choose this item.

**Transmit Windows**
A list of currently open Transmit windows is available in this menu. Choose a window to make it active (on top). You can also use the keyboard shortcuts, the numbers one through nine with the command key, to switch between windows.
ACKNOWLEDGMENTS

Transmit 1.5 - Cabel M. Sasser and Steven Frank

Technical assistance:
Richard Atwell, John Daub, Frank Vernon

Thank you:
Peter and Elaine Frank
Mom, Dad, Meegs, Eric, and Kelly!
Matthew Arney & Kato-San
Mat & Sam Caughron
Ian Lynch Smith
Chris "Benchmark" Whittier
Allen “Crash” Carter
Richard “LThread” Atwell
Mike “Ideas” McHugh
Dave “Iconmaster” Brasgalla

Additional Engineering:
MacBinary III - Christopher Evans, Leonard Rosenthol, Peter Lewis
SignatureToApp - Jens Alfke
GetFileIcon - Michael Kamprath, John Daub
CContextualMenu - Dair Grant
FindIcon - James Walker
CWASTEEdit - Timothy Paustian
WASTE - Marco Piovanelli, Dan Crevier
MoreFiles - Jim Luther
Internet Config - Peter Lewis, Quinn "The Eskimo!"
Visual Balloons™ - Andreas Pizsa @ http://www.toolsandtoys.com

RIP: Transit